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Welcome!
Your EPSON Stylus® Photo 820 is an exceptional photo printer that gives you these
advanced features:
■

EPSON’s exclusive 6-color ink technology produces beautiful digital photos that
look like traditional photographs, as well as crisp everyday documents of all types.

■

Four-picoliter variable droplet ink technology achieves finer shadow detail,
dazzling highlights, and better fill across a wider range of colors.

■

Photo-optimized black ink yields rich blacks that exceed the density of traditional
prints.

■

Ground-breaking Resolution Performance Management™ (RPM) technology
optimizes the number and placement of ink droplets on a variety of papers for
superior photo quality and performance, with manageable print file sizes.

■

Versatile paper handling lets you create BorderFree,™ frame-ready prints in a
variety of sizes.

■

Genuine EPSON ink and papers deliver long-lasting, water-resistant prints.
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PRINT Image Matching and Exif Print
Your EPSON Stylus Photo 820 printer supports these innovative digital image
formats to give you the best photo prints possible:
■

PRINT Image Matching

■

Exif Print

About PRINT Image Matching
EPSON’s revolutionary PRINT Image Matching™ (P.I.M.) technology lets your
digital camera and printer work together automatically to produce the best prints
possible. Digital camera manufacturers that support PRINT Image Matching include
EPSON, Casio,® Konica,® Kyocera,® Minolta,® Nikon,® Olympus,® Pentax,® Ricoh,®
Sanyo,® Sony,® and Toshiba.® Check with your camera’s manufacturer or visit
www.printimagematching.com to find out if PRINT Image Matching technology is
included with your camera.
With PRINT Image Matching, the digital camera manufacturer can set specific
printing options for each camera model. These options include:
■

contrast, sharpness, and brightness

■

gamma level, color space, color saturation, and noise reduction

■

shadow point, highlight point, and color balance

The camera saves this information in each image file. Your printer—along with
P.I.M.-enabled software, such as EPSON Software™ Film Factory,™ the P.I.M.
Plug-in for Adobe® Photoshop,® or ArcSoft™ PhotoImpression™ (included with your
printer)—uses the information to ensure the most accurate image reproduction.
But don’t worry if your camera doesn’t include PRINT Image Matching
technology—your EPSON Stylus Photo 820 gives great photo printing results, just
without the adjustments P.I.M.-enabled cameras may add.
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About Exif Print
The Exif (Exchangeable Image File) Print format includes information about your
digital camera settings in JPEG files so your printer and application can use them to
create accurate print settings. Most digital cameras store Exif Print information such
as shutter speed, metering, flash, and exposure settings, resolution, and lens use in the
JPEG image file. Your printer—along with EPSON Software Film Factory or ArcSoft
PhotoImpression—uses the information to ensure the most accurate image
reproduction.

About Your Software
The CD-ROM that came with your printer includes all the software you need for
printing. See the Start Here sheet for installation instructions.
■

Your printer driver runs your printer and lets you control how your documents
look. You can’t print without it.
Tip: It’s a good idea to check EPSON’s support web site periodically for free
updates to your printer driver. Visit http://support.epson.com. Download
instructions are posted for your convenience.

■

Your photo software includes these great tools:
EPSON Software Film Factory is a photo management program
that lets you organize, beautify, and print your photos in a flash.
Supports PRINT Image Matching and Exif Print (except with
Mac® OS X).
P.I.M. Plug-in for Adobe Photoshop lets you retain PRINT Image Matching
image quality when you import JPEG files from your P.I.M.-enabled digital
camera. (Compatible with Photoshop 6.0, 7.0, and Photoshop Elements 1.0.)
ArcSoft PhotoImpression is an easy-to-use photo editing
program that lets you edit, enhance, retouch, or add special
effects to any image with just a few clicks. Supports PRINT
Image Matching and Exif Print (except with Mac OS X).

Welcome!
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■

Your EPSON Printer Information Center gives you quick,
on-screen access to information about your printer. It includes
EPSON Print Show animated tutorials on loading special paper,
replacing ink cartridges, improving print quality, and other tasks. It
also includes your on-screen Reference Guide for complete
information about your printer. (The desktop icon may be different
on some Mac OS X systems.)

■

EPSON PhotoCenterSM is EPSON’s free photo-sharing web site
where you can store, organize, and share your photos; print
high-resolution photos straight from the web; and create free online
postcards with your photos. Your printer software installer lets you
add a link to the EPSON PhotoCenter on your desktop.

About Your Documentation
To set up your printer and install its software, see the Start Here sheet.
This book contains system requirements, important safety information, your
warranty, and instructions on:
■

Using the EPSON Printer Information Center

■

Printing with Windows® or on a Macintosh®

■

Maintaining the printer

■

Solving basic problems

Please follow these guidelines throughout:
Warnings must be followed carefully to avoid bodily injury.
Cautions must be observed to avoid damage to your equipment.
Notes contain important information about your printer.
Tips contain hints for better printing.

For more details about your printer, use your EPSON Printer Information Center,
described on page 5.
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Using the EPSON Printer Information
Center
Need help loading special paper, replacing ink cartridges, or cleaning the print head?
Use the EPSON Printer Information Center (EPIC) to view printer movies that
quickly tell you how. EPIC also includes an on-screen Reference Guide with additional
printer details. Follow the instructions on the Start Here sheet to install the EPSON
Printer Information Center, if you haven’t already.
Note: You need a browser—such as Microsoft® Internet Explorer® 4.0 or later or
Netscape Navigator® 3.0 or later—to view the manual. If you are using a different
browser, the pages may not display correctly.

Launching the Movies
EPSON Printer Information Center icon on your
1. Double-click the
desktop. (The desktop icon may be different on some Mac OS X systems.)

2. Click Print Show.
3. Click the appropriate topic, then click the title of the movie you want to watch.
Use the program tools to pause a movie, replay a step, or skip ahead.

Click a topic,
then click a
title on the
next screen

4. Click Exit to exit Print Show.

Welcome!
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Launching the Manual
1. Double-click the
desktop.

EPSON Printer Information Center icon on your

2. Click Reference Guide. You see this screen:

Click here to
expand the table
of contents

3. Click a topic on the left to expand the table of contents.
4. Click on the topic you want to view.
■

Click right arrows

■

Click down arrows

to view subtopics, then click on a topic.
to close subtopic lists.

Closed list,
click to expand
Click to go
to a topic

Note: If you see an icon for a graphic when viewing your Reference Guide in
Netscape Navigator, click the Reload button to load the graphic.
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Printing From Start to Finish
Follow the instructions in these sections to print using all your printer’s features:
■

“Loading Paper” on page 8

■

“Basic Printing in Windows” on page 10

■

“Basic Printing on a Macintosh” on page 12

■

“Customizing Your Print Settings” on page 17

■

“Selecting the Correct Media Type” on page 21

■

“Printing BorderFree Photos” on page 22

■

“Using PRINT Image Matching” on page 24
Tip: Whenever you print, make sure you:
■

Use the right paper.
For the best-looking photos, most vivid colors, and greatest detail, always use
genuine EPSON papers and EPSON ink.

■

Choose the right printer settings for the paper.
Make sure your printer settings are correct for the document you’re printing and
the paper you’ve loaded. Your printer automatically adjusts itself for the type of
document and paper you’ve selected.
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Loading Paper
1. Slide the left edge guide to the approximate width of your paper.
2. Place your paper in your printer on the right side of the feeder, behind the tab.
3. Press in the locking tab on the left edge guide and slide it to fit lightly against the
paper.
4. Open the output tray extension.

Follow these guidelines when loading paper:
■

Always load the short edge first, even when you’re printing landscape-oriented
documents.

■

Load the printable side face up. It’s usually whiter or brighter than the other side.

■

Load letterhead or preprinted paper into the printer top edge first.

■

Don’t load paper above the tabs inside the edge guides.

See your Print Show movies for instructions on loading various types of special paper.
EPSON Printer Information Center icon on your desktop.
Select the

8
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Loading Envelopes
1. Load up to 10 envelopes, flap edge first and printable side up.
Tip: For best results, press each envelope flat before loading it, or load one
envelope at a time.

2. Place the envelopes against the right edge of the sheet feeder, beneath the tab.
3. Press the locking tab on the left edge guide and slide it against the envelopes.

Load with the
printable side up,
flap side down

4. Before you print, make sure you choose the correct envelope size as the paper Size
(Windows) or Paper Size (Macintosh) setting. See page 10 (Windows), page 12
(Macintosh OS 8.6 to 9.x), or page 14 (Macintosh OS X) for instructions.

Printing From Start to Finish
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Basic Printing in Windows
After you create a document in a software program, follow these steps to print it using
the basic printer settings:
1. From the File menu, click Print. You see a Print window like this one:
Check for your printer name here

Click here to open
your printer
software

2. Make sure EPSON Stylus Photo 820 Series is selected.
3. Click the Properties or Preferences button. (If you see a Setup, Printer, or
Options button, click it. Then click Properties or Preferences on the next
screen.)

10

Printing From Start to Finish

4. Select the following settings on the Main tab in your printer settings window:
1 Select the type of document you’re printing:
Draft: for rough drafts with
reduced print quality
Text: For text-only
documents (like letters) with
good print quality

2 Select your paper
type (see page 21)

Text & Image: For
documents with text and
images with higher print
quality

3 Select your paper
size

Photo: For photos and
graphics with good print
quality and speed

4 Select your
document or
image orientation

Best Photo: For photos or
graphics with high print
quality

5 Click OK

Tip: For more information about printer settings, click the

or Help button.

5. You return to the Print window. Click OK or Print to start printing.
During printing, this window appears and shows the progress of your print job. You
can use the buttons to cancel, pause, or resume printing. You can also see how much
ink you have left.

Click to cancel printing
Click to pause or
resume printing

Printing From Start to Finish
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Selecting the Settings You Use Most Often
Your printer settings apply only to the program you’re currently using. If you want,
you can change the Windows default printer settings for all your programs.
1. Right-click the

printer icon in the lower right corner of your screen (taskbar).

2. Select Printer Settings. You see the window shown on page 11.
3. Select the default settings you want for all your applications, then click OK.
You can still change the printer settings in your program, if necessary.

Basic Printing on a Macintosh
After you create a document in a software program, follow the steps in one of these
sections to print it using the basic printer settings:
■

For Macintosh OS 8.6 to 9.x applications, see the next section.

■

For Macintosh OS X applications, see page 14.

Printing with OS 8.6 to 9.x
Before you begin, make sure you selected your printer in the Chooser as described on
the Start Here sheet.
1. From the File menu, select Page Setup. Select the following settings:
1 Make sure you see SP820 Series

2 Select your paper size
3 Select the orientation of your
document or image

2. Click OK to close the Page Setup window.
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3. From the File menu, select Print. Select the following settings:
1 Select your paper type
(see page 21)
2 Select Color (for color
documents and black
and white photographs)
or Black (for black text
documents)
3 Select Automatic mode
4 Select Quality or Speed
(for faster printing)

Tip: For more information about printer settings, click the

button.

4. You can also do the following:
■

Click
to reduce/enlarge your printed image, print multi-page layouts, or
add a watermark.

■

Click

■

Click

■

Click

to control background printing and schedule print jobs.
, then click Preview to preview your printout.
to check your ink levels.

5. Click Print.
6. If you turned on background printing, you can select EPSON Monitor3 from the
Application menu in the upper right corner of the screen. You see the EPSON
Monitor3 window:
Select your print job,
then click here to
cancel printing

Click to check
ink levels

Note: If you’re not using background printing and you need to cancel printing,
hold down the J key and press the . (period) key.
Printing From Start to Finish

13

Printing with OS X
If you’re using an OS X compatible printing application, follow the steps below to
print a document. (If you’re using an application that’s compatible only with
Macintosh Classic mode, follow the steps on page 12 instead.)
Before you begin, make sure you added your printer to Print Center as described on
the Start Here sheet.
1. From the File menu, select Page Setup.
2. Select the following Page Setup settings as necessary:
Select SP820 Series
from the Format for
pop-up menu

Select the Paper Size,
Orientation, and any
other settings you
want to use

3. When you’re finished, click OK.
4. Select Print from the File menu. You see a screen like this:

Click here and
select Print
Settings

5. Select Print Settings from the pull-down menu.
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6. Select the following Print Settings as necessary:

1 Select your paper type
(see page 21)
2 Select Color (for color
documents and black
and white photographs)
or Black for black text
documents
3 Select Automatic mode
4 Select Quality or Speed
(for faster printing)

Tip: For more information about printer settings, click Help. The OS X printer
driver contains a subset of the settings available with the OS 8.6 to 9.x Macintosh
printer driver described in this book.

7. You can also choose other print settings by selecting these options in the
pull-down menu:
■

Copies & Pages, to select the number of copies or a page range

■

Layout, to select page layout options

■

Output Options, to save your print job as a PDF file

■

Color Management, to select ColorSync,® adjust the color controls, change

the gamma setting, or turn off color adjustments by the printer software
■

Summary, to view a list of all your selections

■

Save Custom Setting, to save your selections for future use.

8. Click Print.

Printing From Start to Finish
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9. To monitor the progress of your print job, click the Print Center icon when it
appears in the dock on the bottom of your desktop. You see a screen like this:

10. Monitor the progress of your print job or do one of the following:
■

click the print job, then click Delete to delete the job

■

click the print job, then click Hold to pause printing

■

click a print job marked “Hold” and click Resume to resume printing

■

if multiple print jobs are listed, click a print job, then click the Priority arrow
as necessary to reorder the jobs

11. When you’re finished, close Print Center.
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Customizing Your Print Settings
You can use advanced settings for color matching, printing at a higher resolution, or
selecting a variety of special effects and layouts.

Customizing Windows Print Settings
1. On the Main tab, click the Advanced button in the bottom right corner of the
window. The Basic settings change to the Advanced settings.
2. Select the following advanced settings as necessary:

1 Select Paper & Quality
options as necessary
Click here to select
Photo RPM for the best
print quality on photo
and glossy paper types
2 Select Print Options as
necessary
Click here to select
Black Ink Only printing
3 Select a color
management method
To choose No Color
Adjustment, click
ICM first

3. Once you’ve finished selecting advanced settings, you can:
■

Click OK to save your settings, return to the Print dialog box, and print.

■

Click the Basic button to return to the Basic settings.

■

Click the Page Layout tab and continue with step 4 to select layout options.

Printing From Start to Finish
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Note: For more information about advanced settings, or instructions on saving
them as a group so you can reuse them later, click the Help or
button. If you
want to use the Advanced screen each time you access your printer settings,
select the Show this screen first checkbox.

4. Select the following page layout settings as necessary:
1 Select image or
document position
options here
2 Select image or
document resizing
options here; these
affect only your
printed image

4 Select multi-page
document options
here and here

3 Add a watermark to
your printed page
here

Note: For more information on page layout settings, click the Help or

To print a large
image on several
sheets to make a
poster, select
settings here

button.

5. Click OK to save your settings, return to the Print dialog box, and print.
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Customizing Macintosh Print Settings
1. On the printer settings window, click Custom, then click the Custom Settings
list to open it.

Click Custom, then choose:
Economy (to save ink on plain paper) or
ColorSync (to match printed colors with
compatible device colors) from the
Custom Settings list

Macintosh OS X

Macintosh OS 8.6
to 9.x
Click Custom, then choose:
Economy (to save ink on plain paper) or
ColorSync (to match printed colors with
compatible device colors) from the
Custom Settings list

Note: For more information on custom settings, click Help (OS X) or
(OS 8.6 to 9.x).

2. If you’re finished selecting custom settings, click Print to print your document.
To select more custom settings, go to step 3.
3. To access advanced settings, click Custom, then click Advanced (OS 8.6 to 9.x)
or click Advanced Settings (OS X).

Printing From Start to Finish
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4. Select these advanced settings as necessary:

1 Click here to select
Photo RPM for the best
print quality on certain
paper types

2 Select various print
options here
3 Select color management
settings here
Macintosh OS 8.6 through 9.x

1 Click here to select Photo RPM
for the best print quality on
photo and glossy paper types

2 Select various print options here

3 To select color management
settings, select Color
Management from the Print
Settings pull-down menu
Macintosh OS X

Note: For more information on advanced settings, or instructions on saving them
as a group so you can reuse them later, click Help (OS X) or
(OS 8.6 to 9.x).

5. OS 8.6 to 9.x: Click OK to save your settings, then click Print.
OS X: Click Print.
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Selecting the Correct Media Type
Select the correct Type or Media Type setting so your
printer knows what kind of paper you’re using and adjusts
the ink coverage accordingly.

For this paper . . .

Select this Type or Media Type
setting . . .

Plain paper sheets or envelopes

Plain paper

EPSON Premium Bright White Paper
EPSON Iron-On Transfer Paper

360 dpi Ink Jet Paper

EPSON Photo Quality Ink Jet Paper

Photo Quality Ink Jet Paper

EPSON Photo Quality Ink Jet Cards
EPSON Photo Quality Self Adhesive Sheets
EPSON Matte Paper Heavyweight

Matte Paper - Heavyweight

EPSON Double-Sided Matte Paper
EPSON Photo Paper
EPSON Glossy Photo Paper

Photo Paper or
Glossy Photo Paper

EPSON All Purpose Glossy Paper
EPSON Photo Quality Glossy Paper
EPSON Glossy Photo Greeting Cards
EPSON Premium Glossy Photo Paper

Premium Glossy Photo Paper

EPSON Photo Stickers®

Photo Quality Glossy Film

EPSON Photo Quality Glossy Film
EPSON Ink Jet Transparencies

Ink Jet Transparencies

EPSON ColorLife™ Photo Paper

ColorLife Photo Paper

EPSON Premium Luster Photo Paper

Premium Luster Photo Paper

EPSON Premium Semigloss Photo Paper

Premium Semigloss Photo Paper

Printing From Start to Finish
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Printing BorderFree Photos
You can print your photos with no margins, extending the image all the way to the
edges of the page. Although BorderFree printing is a bit slower (especially near the
edges), you get beautiful snapshots or enlargements, without trimming. (Not available
with Macintosh OS X.)
BorderFree printing supports the following paper types and sizes:
Type or Media Type
setting

EPSON paper name

Sizes

Photo Paper or Glossy Photo Paper

Letter-size
4 × 6 (with or without
perforated edges)

Glossy Photo Greeting Cards

8 × 10 (with
perforated edges)

Premium Glossy Photo Paper

Letter-size
8 × 10
5×7
4×6

Premium Glossy Photo
Paper

Premium Semigloss Photo Paper

Letter

Premium Semigloss
Photo Paper

Premium Luster Photo Paper

Letter

Premium Luster Photo
Paper

Matte Paper Heavyweight

Letter-size
8 × 10

Matte Paper Heavyweight

Photo Paper or
Glossy Photo paper

Tip: For instructions on loading special paper, such as 4 × 6-inch Photo Paper,
select the
EPSON Printer Information Center icon on your desktop and
choose a paper loading movie.

Follow these steps to print BorderFree photos:
1. Start your printing application and open your photo file.
2. Access the printer settings window (see page 10 for Windows or page 13 for
Macintosh OS 8.6 to 9.x).
3. Windows only: Select Photo or Best Photo as the Quality Type setting.
4. Select your paper type as the Type (Windows) or Media Type (Macintosh)
setting. See the table above.
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5. Windows: Click the Borderless checkbox, then select your paper size as the Size
setting.
Macintosh: Click OK. Then click File > Page Setup. Click the No Margins
checkbox, then select your paper size as the Paper Size setting.

Macintosh

Windows

6. Select Portrait or Landscape as the Orientation setting.
7. Click OK.
8. Windows: Click OK or Print.
Macintosh: Click File > Print, then click Print.

Printing From Start to Finish
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Using PRINT Image Matching
With PRINT Image Matching, special print instructions are saved in your digital
photo files. For example, macro mode pictures might include print commands for
sharpness and clarity, while portrait mode pictures might emphasize soft focusing and
subtle flesh tones. If your digital camera supports PRINT Image Matching, you can
use this technology when you print with:
■

Film Factory, as described below, or

■

P.I.M. Plug-in for Adobe Photoshop, as described on page 29, or

■

ArcSoft PhotoImpression (see the help utility that comes with the program for
printing instructions).

Using Film Factory
If your digital camera supports PRINT Image Matching or Exif Print, you can use
these technologies when you print with Film Factory to ensure the most accurate
image reproduction (not available with Macintosh OS X). Printing with P.I.M. isn’t
complicated, and it provides the color corrections right from your P.I.M. image file,
so you don’t have to correct them yourself. Just leave the PRINT Image Matching
box checked.
You can also use Film Factory to organize, retouch, and print non-P.I.M. and
non-Exif Print digital images.
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Opening Your Photos in Film Factory
Follow these steps to print P.I.M. photos with Film Factory:
1. Start Film Factory. You see the main Film Factory screen:
Click Roll to create a
new roll, or . . .
click an existing roll

PRINT Image
Matching photos
are marked here

Note: If you need help with Film Factory, select it from the Help menu or check
the on-screen Getting Started Guide that was installed with Film Factory.

2. Select a “roll of film” or click the Roll button and select New Roll.
3. If your photos were taken with a digital camera that supports PRINT Image
Matching, the P.I.M. logo appears in your photo thumbnails. Right-click
(Windows) or Ctrl-click (Macintosh) a photo thumbnail to display information
about the P.I.M. and/or Exif Print data in the photo file. (If you retouched a
PRINT Image Matching photo, the P.I.M. logo may not appear.)
4. Click the photo you want to print, or click the All button at the top of the screen
to select all the photos in a roll. Then go to step 6.

Printing From Start to Finish
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5. To import a photo into Film Factory, click the Import button, then:
■

Click From File to import a photo from your computer’s hard drive.

■

Click From Removable Media to import a photo from a disk or CD-ROM.

■

Click From PC Card to import a photo from a PC card in a card reader.

■

Click From Twain Device to import a photo from a scanner or digital
camera. If your device is already selected, the software will open. If not, click
Import Settings, and select your scanner or digital camera. (Not applicable
to OS X.)

6. Click a button on the left to select a print option. For
example, click the Standard Prints button. You see buttons
for each step you need to follow, as shown.
7. Click Import & Retouch to retouch or edit your photo, if
necessary.
Note: You can rotate, trim, and correct for red eyes and still
retain P.I.M. or Exif Print image quality with your photo.
However, if you adjust other settings, such as brightness
and color, your P.I.M. or Exif Print image quality will be lost.
To ensure you keep P.I.M. or Exif Print image quality in your
original photo file, make a copy of the photo before you
edit. Then make edits only to your copy.

8. When you’re ready to print, continue with the steps in the next section.
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Printing Your Photos
1. When you’re ready to print, click the Print Assignment button. You see this
screen:

Click to print the
date with your
photo
Select your printer
settings here

2. Windows and Macintosh OS 8.6 to 9.x: Select these options in the Printer
Settings box at the bottom of the screen, in this order:
1 Make sure your
printer is selected
3 Select your
paper size
4 Select a
Media Type
2 Select Sheet Feeder or Sheet Feeder
(No Margins) for BorderFree printing

Macintosh OS X: Click the Properties button. Select your printer in the
Format for menu, select the correct Paper Size setting, and click OK.
(BorderFree printing is not available with Film Factory on OS X.)
3. If you want to print the current date with your photo, click the Print Date box.
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4. Click the Print button on the left side of the screen. You see more options:

Select the
number of copies
you want to print

Leave these boxes
checked for the
best printed output
using P.I.M. and/or
Exif Print data, if
available

5. If your photo doesn’t look right in the preview, click the Back button to change
your settings. (Click the Detailed Preview button for a closer look.)
6. Select the number of copies you want to print.
7. Leave the PRINT Image Matching and/or Exif Print box checked for the best
results when printing photos containing P.I.M. and/or Exif Print data. (Not
applicable to OS X.)
8. Click the

Print button at the top of the screen.

■

Windows: Your pictures are printed.

■

Macintosh OS 8.6 to 9.x: You see the Print window; click Print. Your
pictures are printed.

■

Macintosh OS X: You see the Print window. Select Print Settings from the
Copies & Pages pull-down menu. Then select your Media Type and other
print settings as necessary, and click Print.

Store your prints in resealable plastic bags, photo albums, or glass-covered picture
frames. Keep your pictures and unused paper away from high temperatures, humidity,
and direct sunlight. Make sure you return unused paper to its original package.
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Using the P.I.M. Plug-in for Adobe Photoshop
The P.I.M. Plug-in for Adobe Photoshop allows you to retain the P.I.M. image quality
when you import JPEG files from your P.I.M.-enabled digital camera. The P.I.M.
Plug-in works with Photoshop 7.0, 6.0, and Photoshop Elements 1.0. You’ll also need
to use the ICC profiles for your printer that are installed with the plug-in (Windows)
or the printer driver (Macintosh).
Photoshop doesn’t retain the PRINT Image Matching information separately in the
JPEG’s header file when you import your P.I.M. image. Instead, it converts that
information in the file and embeds a color space called EPSON RGB 2001. This
profile supports all the P.I.M. color advantages and enhancements.
You can crop, rotate, resize, work with layers, play with filters, and even make
selective color adjustments to the P.I.M. image while retaining P.I.M. quality.
However, you won’t benefit from global color adjustments (such as Auto Levels, Auto
Contrast, Auto Color, etc.). Also, if you try to use your new Photoshop file in another
P.I.M.-enabled software program, it won’t be recognized as a P.I.M. image. You need
to keep your original file if you want to take advantage of P.I.M. information in other
programs.
Note: To install the P.I.M. plug-in for Mac OS X, insert the printer software CD-ROM,
and drag the P.I.M. Plug-In icon to the Photoshop Plug-Ins folder on your Macintosh.

Importing a P.I.M. Image
1. If you’re using Photoshop Elements, change
your color settings before importing a P.I.M.
image. Select Color Settings from the Edit
menu, then select Full color management optimized for Print and click OK.
2. Open the File menu and select Import >
PRINT Image Matching. You see a window
like this:
3. Select the folder containing your P.I.M.
images. (In Windows, all your JPEG files are
listed; on a Macintosh, only P.I.M. files
appear.)
4. Select the P.I.M. image you want to import.
Printing From Start to Finish
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5. To see a preview of the selected P.I.M. image, check the PRINT Image Matching
Preview box.
6. Click the Open button. Your image opens and the window remains on the screen.
Note: If you see this screen,
select Use the embedded
profile and click OK.

7. Select and open more P.I.M. images, or click Cancel to close the Open PRINT
Image Matching file window. (If you don’t want the window to remain on the
screen after you open a file, uncheck Import consecutively.)
8. Follow the steps in the next section to print your P.I.M. image.
To keep the P.I.M. header information intact for use in other P.I.M.-enabled
programs, keep the original file; don’t use the Photoshop Save command. Instead use
Save As to rename the file. It won’t contain P.I.M. header information, but will
retain P.I.M. image quality, as long as the file is saved with the ICC profile embedded.
Note: If you overwrite your original file, you will lose all P.I.M. header information.

Printing a P.I.M. Image
P.I.M. images are converted into the EPSON RGB 2001 color space. To retain
P.I.M. quality and enhancements, don’t change the color space.
Note: The illustrations in the sections below show Macintosh screens; Windows
screens will look different, but the settings are the same.

1. Open the File menu, then:
Photoshop 7.0 or Elements: Select Print Preview > Show More Options >
Color Management.
Photoshop 6.0: Select Print.
You see the window shown on the next page.
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Photoshop 7.0/Elements

Photoshop 6.0

Select the profile for your printer and paper
Make sure this source is selected

2. In the Source Space box, make sure the EPSON RGB 2001 option is selected.
3. In the Print Space box, select the SP820 profile for the paper you’re printing on.
We recommend Perceptual as the Intent setting.
4. Photoshop 7.0 or Elements: Click Print. You see the printer settings window.
Photoshop 6.0: Go to step 5.
Note: In Windows, click Setup, then select your printer and click Properties or
Preferences to select these settings.

5. Windows only: Select Photo or Best Photo.
6. Select the paper you’re printing on as the Type (Windows) or Media Type
(Macintosh) setting.
7. Windows: Click the Advanced button. The Basic settings change to the
Advanced settings.
Macintosh 8.6 to 9.x: Under Mode, click Custom, then click the Advanced
button. You see the Advanced screen.
Macintosh OS X: Click the Advanced Settings button. You see the Advanced
options.

Printing From Start to Finish

31

8. Windows: Select ICM, then select No Color Adjustment and click OK.
Macintosh 8.6 to 9.x: Select No Color Adjustment and click OK.
Macintosh OS X: Select Color Management from the pop-up menu, then select
No Color Adjustment.

Macintosh 8.6 to 9.x
Windows

No Color Adjustment

Macintosh OS X

9. Continue clicking OK (Windows) or click Print (Macintosh) to print your photo.
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Maintaining Your Printer
Follow the instructions in this chapter to keep your printer working at its best and
prepare it for moving, if necessary.
■

“Cleaning the Print Head” below

■

“Replacing an Ink Cartridge” on page 35

■

“Aligning the Print Head” on page 39

■

“Cleaning the Printer” on page 40

■

“Transporting the Printer” on page 41

Cleaning the Print Head
If your printouts are unexpectedly light, or dots or lines are missing, you may need to
clean the print head. This unclogs the nozzles so they can deliver ink properly. Print
head cleaning uses ink, so clean it only if quality declines.
This section explains how to clean the print head using the Head Cleaning utility
(available only when the printer is connected directly to your computer, not over a
network).
You can also clean the print head by holding down the b maintenance button on the
printer for three seconds (when the red b error light is off).
For more information about cleaning the print head, see your Print Show movies;
select the
EPSON Printer Information Center icon on your desktop.
Caution: When you don’t turn on your printer for a long time, the print quality can
decline, so turn it on at least once a month to maintain good print quality.
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Running the Head Cleaning Utility
1. Make sure the printer is turned on but not printing, and the red b error light is
off. (If the red light is flashing or on, you may need to replace the ink cartridge;
see page 35 for details.)
2. Windows: Right-click the
printer icon on your taskbar (in the lower right
corner of your screen). Select Head Cleaning.
Macintosh OS 8.6 to 9.x: Choose File > Page Setup or Print. Click the
Head Cleaning button.
Utility button, then click the
Macintosh OS X: Open the Applications folder and select EPSON Printer
Utility. Select SP820 Series in the printer list, click OK, and select Head
Cleaning.
3. Follow the instructions on the screen to
clean the print head.
Cleaning takes about 30 seconds, during
which the printer makes some noise
and the green P power light flashes.
Caution: Never turn off the printer while
the green P power light is flashing, unless
the printer hasn’t moved or made noise
for more than 5 minutes.

4. When the green P power light stops flashing, make sure paper is loaded in the
printer and click Print nozzle check pattern. Then click Print. The nozzle check
pattern prints (see the next section for details).
5. If the nozzle check pattern has no gaps or lines, click Finish.
If the pattern has white lines, click Clean to clean the print head again.
If you don’t see any improvement after cleaning three or four times, check the
solutions beginning on page 48. You can also turn the printer off and wait
overnight—this allows any dried ink to soften—and then try cleaning the print
head again.
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Examining the Nozzle Check Pattern
Examine the nozzle check pattern you
print. Each colored square should be
solid, with no gaps or lines, as shown:
■

If your printout looks okay, you’re done.

■

If you see any white lines or gaps
(as shown), clean the print head
again; see page 34 for instructions.

Replacing an Ink Cartridge
When the red b error light flashes, an ink cartridge is low on ink. (You may also see
a message on your screen.) This is a good time to obtain a new cartridge. When the
red b error light stays on, you may need to replace one of the cartridges.
When a cartridge is more than six months old, you may need to replace it if printouts
don’t look their best. If the quality doesn’t improve after cleaning and aligning the
print head, you can replace the cartridge even if the red b error light is off.
Note: The red b error light also comes on if your paper runs out or is jammed, so
make sure to check your paper before replacing a cartridge.

Checking the Ink Supply
To check your ink supply, do one of the
following:
■

Windows: Double-click the
icon in
the lower right corner of your screen. If a
cartridge is low on ink, you’ll see a
window like this:
Or right-click the
icon and select
Ink Monitor to see your ink levels.
Click Buy Now to launch your web
browser and order ink cartridges online.
Maintaining Your Printer
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■

Macintosh:
OS 8.6 to 9.x: Choose File > Print. Click the

ink icon.
OS X: Choose Applications > EPSON Printer
Utility > SP820 Series > Status Monitor.

You see a window like this:
Click a cartridge image to display information about
the cartridge.

Purchasing Ink Cartridges
Use these EPSON ink cartridges within six months of installing them and before the
expiration date on the package:
Black ink cartridge:

T026201

Color ink cartridge:

T027201

(May be labelled T026 or T027.)
Caution: To ensure good results, use genuine EPSON ink cartridges and do not
refill them. Other products may cause damage to your printer not covered by
EPSON’s warranty.

When you need new ink cartridges, contact your dealer, or call the EPSON StoreSM at
(800) 873-7766 or visit www.epsonstore.com (U.S. sales only). In Canada, please call
(800) 463-7766 for dealer referral.

Ink Cartridge Precautions
Warning: Keep ink cartridges out of the reach of children and do not drink the ink.
If ink gets on your hands, wash them thoroughly with soap and water. If ink gets
in your eyes, flush them thoroughly with water.
Caution: To avoid damaging the printer, never move the print head by hand.
You cannot print if either ink cartridge is empty. Leave the empty cartridge
installed in the printer until you have obtained a replacement. Otherwise the ink
remaining in the print head nozzles may dry out.
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Removing and Installing Ink Cartridges
Be sure you have a new ink cartridge before you begin. Once you start replacing a
cartridge, you must complete all the steps in one session.
1. Make sure the printer is turned on (the green P power light should be on, but not
flashing). Then open the printer cover.
2. Press the e ink cartridge replacement
button. The print head moves to the center
and the green P power light flashes.
The red b error light also begins to flash or
remains on.
■

If it flashes at the same speed as the green
P power light, replace the black
cartridge.

■

If it flashes twice as fast as the green P power light, replace the color cartridge.

■

If it remains on, replace both cartridges.

3. The color cartridge is on the right and the
black is on the left.
Pull up the ink cartridge clamp. The cartridge
rises up from its holder.
4. Lift the cartridge out of the printer and
dispose of it carefully.
5. Unwrap the new ink cartridge. Then
remove only the yellow tape seal on top.
Caution: You must remove the yellow
tape from the top of the cartridge or
you will permanently damage it.
Don’t touch the green circuit board on
the back of the cartridge; you may
inhibit normal operation and printing.

black cartridge

color cartridge

don’t touch the green circuit boards
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6. Lower the new cartridge down into
the holder.
Make sure the tabs rest on the hooks
in back.

hooks

Caution: Don’t place the cartridge
under the hooks; you may damage the clamp
when you close it.

7. Press down firmly on the ink cartridge
clamp until it snaps in place.
8. If you need to replace the other ink
cartridge, repeat steps 3 through 7 before
continuing with step 9.

9. Press the e ink cartridge replacement
button and close the printer cover. The
printer begins charging the ink delivery
system.
The green P power light flashes and the
printer makes noise. Charging takes about
half a minute. When it’s finished, the green
P power light stops flashing and stays on,
and the red b error light goes out.
Caution: Never turn off the printer while the green P power light is flashing,
unless the printer hasn’t moved or made noise for more than 5 minutes.
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Aligning the Print Head
If your printouts contain misaligned vertical lines, or you see white or black horizontal
banding, you may need to align the print head.
Note: Your printer must be connected directly to your computer (not over a
network) to use the Print Head Alignment utility.

1. Turn on the printer.
2. Load plain, letter-size paper.
3. Windows: Right-click the
printer icon on your taskbar (in the lower right
corner of your screen) and select Print Head Alignment.
Macintosh OS 8.6 to 9.x: Choose File > Page Setup or Print. Click the
Print Head Alignment button.
Utility button, then click the
Macintosh OS X: Open the Applications folder and select EPSON Printer
Utility. Select SP820 Series in the printer list, click OK, and select Print Head
Alignment.
4. Follow the instructions on the screen to
print a test page. You see this window:
5. On the test page, select the pattern with
the two vertical lines most precisely
printed on top of each other. You may
need to use a magnifying glass or loupe.

Select one pattern each for rows 1, 2, and 3. Then enter the number of the best
pattern for each row in the corresponding boxes on the screen. Then click Finish.
If you can’t find an aligned pattern, click Realignment to print another test page,
then repeat this step.
Maintaining Your Printer
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Cleaning the Printer
To keep your printer working at its best, you should clean it several times a year.
Follow these steps:
1. Turn off the printer, unplug the power cord, and disconnect the printer cable.
2. Remove all paper, then use a soft brush
to clean any dust or dirt from the sheet
feeder.

Don’t touch the metal carriage shaft

3. Clean the exterior of the printer with a
soft, damp cloth.
4. Clean ink out of the printer’s interior
with a soft, damp cloth. Clean the areas
shown here:

Clean
here

Warning: Don’t touch the gears inside
the printer.
Caution: Be careful not to wipe the metal carriage shaft.
Never use a hard or abrasive brush, or alcohol or thinner for cleaning; they can
damage the printer components and case.
Don’t get water on the printer components and don’t spray lubricants or oils
inside the printer.
Don’t use any cleaning sheets included with special paper; they may jam inside
the printer.
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Transporting the Printer
If you move your printer some distance, you need to prepare it for transportation in
its original box or a similar one. Follow these steps:
Caution: To avoid damage, always leave the ink cartridges installed when
transporting the printer.

1. Turn on the printer, wait until the print head locks in the far right position, then
turn off the printer.
2. Unplug the power cord from the electrical outlet. Then disconnect the printer
cable from the printer.
3. Remove any paper from the printer and remove the paper support.
4. Open the printer cover. If you still have the
packing insert, slide it down into the area
beside the ink cartridge holder and tape it to
the printer case. If you don’t have the insert,
just tape the cartridge holder to the printer
case. Then close the printer cover.

Tape the ink cartridge
holder to the printer case

Caution: Be sure to remove the tape
and insert after installing the printer in its
new location.

5. Push in the output tray extension and close the tray.
6. Repack the printer and its attachments in the original box using the protective
materials that came with them.
Keep the printer level as you transport it.
After transporting the printer, remove the tape securing the print head and test your
printer. If you notice a decline in print quality, clean the print head (see page 33); if
output is misaligned, align the print head (see page 39).
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Solving Problems
See “Diagnosing Printer Problems” on page 44 to help determine what the cause of
your printer problem may be. Then see these sections for solutions:
■

“Setup and Software Installation Problems” on page 46

■

“Printer Problems” on page 47

■

“Quality Problems” on page 48

■

“Paper Problems” on page 50

■

“Miscellaneous Problems” on page 50

■

“Uninstalling and Reinstalling Printer Software” on page 52

■

“Where To Get Help” on page 53
Tip: It’s a good idea to check EPSON’s support web site periodically for free
updates to your printer driver. Visit http://support.epson.com. Download
instructions are posted for your convenience.

Printer Parts
paper support
printer cover
left edge
guide

output tray
output tray
extension
power button
and light
maintenance
button/error light

ink cartridge
replacement button
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Diagnosing Printer Problems
First, check the printer’s lights (see below) or run a printer check (see page 45).
Lights

Explanation

Green P power light
flashes

The printer is receiving a print job, replacing an ink cartridge,
charging ink, or cleaning the print head.

Red b error light is
on

Your paper ran out, ink ran out, or paper is jammed. You may also
see a message on your screen.
■
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If paper is out, load more paper, then press the
b maintenance button to resume printing.

■

If paper is jammed, first press the b maintenance button
to eject the paper. If that doesn’t work, turn off the printer,
open the cover, and remove all the paper, including any torn
pieces. Then turn on the printer, reload paper, and press the
b maintenance button.

■

If you see an ink out message on your screen, you need to
replace one of your ink cartridges. See page 35 for details.

Red b error light
flashes

One of the ink cartridges is low. Make sure you have a replacement
cartridge. To determine which cartridge is low, check the ink level
as described on page 35.

Green P power light
is off and red b error
light is on

Paper may be blocking movement of the print head. Turn off the
printer, open the cover, and remove any jammed paper or other
foreign objects. Then turn the printer on again. If the lights are still
on, contact your dealer or EPSON; see page 53 for contact
information.

Green P power light
and red b error light
flash

The printer may have an internal error. Turn off the printer, wait a
few seconds, and turn it on again. If the lights are still flashing,
contact your dealer or EPSON; see page 53 for contact information.

Green P power light
and red b error light
are still on after
replacing an ink
cartridge

One of your ink cartridges is installed incorrectly. Follow the steps
on page 37 to remove your ink cartridges and then reinsert them.

Solving Problems

Running a Printer Check
You can run a printer check to determine whether a problem comes from the printer
or some other source.
1. Turn off your printer and computer.
2. Disconnect the printer’s interface cable.
3. Load letter-size paper in the printer.
4. Hold down the b maintenance
button, then press and release the
P power button. Continue holding
down the b maintenance button until
the green P power light flashes, then
release it.
5. The printer prints one page showing its
ROM version number and a nozzle
check pattern. (If the pattern has lines,
clean the print head; see page 33.)
■

If the test page prints, the problem probably lies in your software settings,
interface cable, or computer, or your software may not be installed correctly.

■

If the test page doesn’t print, you may have a problem with your printer.

Try the suggestions in “Problems and Solutions” beginning on page 46. If
nothing works, contact your dealer or EPSON as described on page 53.
6. Turn off the printer, reconnect the interface cable, then turn on your printer and
computer.

Solving Problems
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Problems and Solutions
Setup and Software Installation Problems
The printer makes noise after ink
cartridge installation.
■

■

When you install ink cartridges,
the printer must charge its print
head for a few minutes. Wait
until it’s finished (the green
P power light stops flashing)
before you turn off the printer,
or it may use excess ink the next
time you turn it on.
Make sure the ink cartridge
clamps are locked down
completely and no packing
material remains in the printer.
Turn off the printer, wait a
moment, then turn it back on to
clear the error.

■

If the SP820 Series icon
doesn’t appear in the Macintosh
Chooser, you may have too
many items in the Chooser.
Delete any unused items.

■

If you see an error message with
Windows 2000, you may not
have software installation
privileges. Contact your System
Administrator.

■

If you’re using Windows 98,
Me, 2000, or XP with a USB
connection, make sure your
system was not upgraded from
Windows 95; the USB driver
may not install correctly.

■

Make sure the USB Controller
is working properly in Device
Manager. See your Windows
help system for details.

■

If you’re printing over a
network, see your on-screen
Reference Guide for instructions
on configuring your printer.

■

In Windows, make sure your
printer is selected as the default
printer in the Printers utility.

You’re having problems installing
the printer software.
■

■
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Turn on your printer and make
sure its cable is securely
connected at both ends. Follow
the installation steps on the
Start Here sheet, and make sure
your system meets the
requirements on page 63.
Close other programs, including
screen savers and virus
protectors, and install again.

Solving Problems

Printer Problems
Only the green P power light is
on, but nothing prints.
■

■

■

Make sure the interface cable is
securely connected at both ends
and meets the system
requirements on page 63.
Run a printer check as described
on page 45. If the test page
prints, make sure your software
is installed correctly.
If you’re printing on a network,
you need to set up your printer
for network printing, as
described in your on-screen
Reference Guide.

Printing is too slow.
Make sure your system meets the
requirements listed on page 63. If
you’re printing a high-resolution
image, you need more than the
minimum requirements. You may
also need to:
■

Clear space on your hard drive
or run a defragmentation utility.

■

Close open programs that
you’re not using.

■

Increase your system’s memory
(RAM).

For the fastest printing, try these
tips:
■

Select Draft as the Quality Type
(Windows) or set the
Quality/Speed slider to Speed
(Macintosh).

The printer sounds as though it is
printing, but nothing prints.
■

The print head nozzles may
need cleaning; see page 33 for
instructions.

■

In the Advanced window, turn
MicroWeave® off (Macintosh
only) and turn High Speed on.

■

The printer won’t operate
properly if it’s tilted or at an
angle. Place it on a flat, stable
surface.

■

If your printer is connected to a
USB hub, disconnect any
unused USB devices.

■

If you’re using the parallel port,
enable ECP/DMA mode on
your computer’s parallel port.
See your computer
documentation or the
manufacturer for instructions.

Your printer makes noise when
you turn it on or after it has been
sitting for awhile.
Your printer is performing routine
maintenance.

Solving Problems
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Quality Problems

Your print is blurry or smeared.

You see banding (light lines).

■

Clean the print head; see
page 33 for instructions.

■

Select a higher print quality and
turn off High Speed mode; see
page 10 (Windows) or page 12
(Macintosh) for details.

■

Select the correct Type
(Windows) or Media Type
(Macintosh) for your paper; see
page 21.

■
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Make sure the printable side of
the paper is face up. It’s usually
whiter or shinier.

■

The ink cartridges may need
replacing. To replace them, see
page 35.

■

Try using Automatic mode
(Macintosh only); see page 13
(OS 8.6 to 9.x) or page 15
(OS X).

■

Align the print head as
described on page 39.

Solving Problems

■

Make sure your paper isn’t
damp or curled, or loaded face
down (the printable side should
be face up). Reload new paper
face up.

■

Use a support sheet with special
paper, or try loading your paper
one sheet at a time.

■

Make sure your paper meets the
specifications listed in the
on-screen Reference Guide.

■

Use EPSON papers for proper
saturation and absorption of
genuine EPSON inks.

■

Align the print head as
described on page 39.

Your printout is faint or has gaps.

■

Clean the print head; see
page 33 for instructions.

■

The ink cartridges may be old or
low on ink; see page 35.

■

Select the correct Type
(Windows) or Media Type
(Macintosh) for your paper; see
page 21.

■

Make sure your paper isn’t
damaged, old, dirty, or loaded
face down. If it is, load new
paper face up. For best results,
use genuine EPSON paper.

Your printout is grainy.
■

Use a higher quality paper or
select a higher Quality Type
(Windows; page 11) or Print
Quality (Macintosh; page 13).

■

Align the print head; see
page 39 for instructions.

■

Increase the image resolution or
print it in a smaller size; see your
software documentation.

You see wrong or missing colors.
■

Make sure Black Ink Only is off
(Windows) or Color ink is
selected (Macintosh), even
when printing black and white
photographs.

■

Clean the print head; see
page 33 for instructions.

■

The ink cartridges may be old or
low on ink; see page 35.

■

Try turning off PhotoEnhance.™
Also check if you’re using a
special effect that alters image
colors, like Sepia.

■

Try using Automatic mode
(Macintosh only); see page 13
(OS 8.6 to 9.x) or page 15
(OS X).

■

Try changing the Gamma
setting; see page 17 (Windows)
or page 20 (Macintosh).

■

Your printed colors can never
exactly match your on-screen
colors. However, you can use a
color management system—
such as ICM (Windows; see
page 17) or ColorSync
(Macintosh; see page 19)—to
get as close as possible.

Solving Problems
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Paper Problems
Paper doesn’t feed correctly or
jams in the printer.
■

■

If paper doesn’t feed, remove it
from the sheet feeder. Fan the
edges of the sheets, reload them
against the right edge (beneath
the tab), then slide the left edge
guide to fit lightly against the
paper.
If paper jams, press the
b maintenance button to clear
the jam. If necessary, open the
cover and remove any jammed
or torn pieces. Load new paper
and press the b maintenance
button.

Paper doesn’t eject fully or is
wrinkled.
■

■
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If the paper doesn’t eject fully,
you may have set the wrong
paper size. Press the
b maintenance button to eject
the paper, then select the correct
paper size.
If it’s wrinkled when it ejects,
the paper may be damp or too
thin. Load new paper.

Solving Problems

Miscellaneous
Problems
The image is inverted, as if viewed
in a mirror.
Turn off Mirror Image (Windows)
or Flip Horizontal (Macintosh) in
the printer software, or the mirror
setting in your program. (If you’re
printing on EPSON Iron-On
Transfer Paper, the image should be
inverted.)
The printer prints blank pages.
■

Make sure your printer is
selected in the Print window, or
the Macintosh Chooser or Print
Center.

■

Clean the print head; see
page 33 for instructions.

You see incorrect characters.
■

Make sure the interface cable is
securely connected at both ends
and meets the system
requirements on page 63.

■

Make sure your printer is
selected in the Print window, or
the Macintosh Chooser or Print
Center.

■

If you’re using a switch box or
USB hub with your printer,
connect the printer directly to
your computer instead.

The margins are incorrect.
■

Make sure the paper settings are
correct for your paper size. See
page 11 (Windows), page 12
(Macintosh OS 8.6 to 9.x), or
page 14 (Macintosh OS X).

■

Choose the correct margins for
your paper size. The margins
must be within the printable
area of the page; see “Printer
Specifications” in your
on-screen Reference Guide.

■

Make sure your paper is
positioned next to the right side
of the feeder and the left edge
guide is snug against the other
side. Don’t load paper above the
arrow on the left edge guide.

Image size or position is
incorrect.
Make sure paper and layout options
are set correctly.
Too many copies are printing.
Make sure that the Copies option in
your printer software or program is
not set for multiple copies.
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Uninstalling and Reinstalling Printer
Software
You may need to uninstall and then reinstall your printer driver and utilities if, for
example, you upgrade your Windows operating system. You don’t need to uninstall
your other photo software or the EPSON Printer Information Center.

Windows
1. Click Start, and select Programs or All Programs.
2. Point to Epson or EPSON Printers,
then select EPSON Printer Software
Uninstall.
3. In the next window, make sure EPSON
Stylus Photo 820 Series is selected
and click OK. Then follow the
on-screen instructions.
4. Restart your computer, then see the Start Here sheet or page 55 to reinstall your
software.

Macintosh OS 8.6 to 9.x
1. Insert your printer software CD-ROM.
EPSON on your desktop, then double-click
2. Double-click
folder that opens. The Main Menu appears.

3. Click Install Printer Driver. On the
Installer screen, click the arrow in the
Easy Install list at the top and select
Uninstall. Then click the Uninstall
button at the bottom and follow the
instructions.
4. Restart your Macintosh, then see the
Start Here sheet or page 55 to reinstall
your software.
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EPSON in the

Macintosh OS X
1. Open the Applications folder, then the Utilities folder.
2. Select Print Center, select SP820 Series, and click the Delete button.
3. Restart your Macintosh, then see page 55 to reinstall your software.

Where To Get Help
If you need help with your printer, Film Factory, or the P.I.M. Plug-in for Adobe
Photoshop, see the contact information below. See the information on page 54 if you
need help with the other photo software that came on your printer CD-ROM.
EPSON provides technical assistance 24 hours a day through the electronic support
services and automated telephone services listed below:
Service

Access

World Wide
Web

From the Internet, you can reach EPSON Support at
http://support.epson.com. At this site, you can download drivers and
other files, look at product documentation, access troubleshooting
information, and receive technical advice through e-mail.

Automated
Telephone
Services

A variety of automated help services are available 24 hours a day, seven
days a week. To use these services, you must have a touch tone
telephone and call (800) 922-8911. Your EPSON SoundAdvice SM
Express Code is 70360. Use this code to quickly select the EPSON
Stylus Photo 820 in SoundAdvice.

To speak to a technical support representative, dial:
■

U.S.: (562) 276-7282, 6 AM to 8 PM, Pacific Standard Time, Monday through
Friday and 7 AM to 4 PM, Saturday.

■

Canada: (905) 709-2567, 6 AM to 6 PM, Pacific Standard Time, Monday through
Friday.

Toll or long distance charges may apply.
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Before you call, please have the following information ready:
■

Product name (EPSON Stylus Photo 820)

■

Product serial number (located on the back of the printer and on its box)

■

Proof of purchase (such as a store receipt) and date of purchase

■

Computer configuration and operating system version

■

Description of the problem

You can purchase ink cartridges, paper, manuals, and accessories from the EPSON
Store at (800) 873-7766 or visit www.epsonstore.com (U.S. sales only). In Canada,
please call (800) 463-7766 for dealer referral.
If you need help with ArcSoft PhotoImpression, use this information:
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■

Web site: www.arcsoft.com/techmain.htm

■

E-mail: support@arcsoft.com

■

Telephone: (510) 440-9901, 8:30 AM to 5:30 PM Pacific Standard Time, Monday
through Friday
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Installing Your Printer Software
Before installing your printer software, follow the steps on the Start Here sheet to set
up your printer and connect it to your printer.
If you’re using Windows XP, Windows Me, or Windows 98, or Mac OS 8.6 to 9.x,
follow the software installation instructions on the Start Here sheet.
If you’re using one of the operating systems below, follow the instructions in this
chapter to install your printer software:
■

“Installing Printer Software on Mac OS X” below

■

“Installing Printer Software on Windows 2000” on page 59

■

“Installing Printer Software on Windows 95” on page 60

Installing Printer Software on Mac OS X
First you’ll install your printer software for OS X applications, then you’ll restart your
Macintosh is OS 9.x and install your printer software for OS 8.6 to 9.x applications.
1. Start up your Macintosh in OS X. (Make sure your printer is still on.)
2. Put the EPSON CD-ROM in your CD-ROM or DVD drive and wait a few
seconds for the CD-ROM to be recognized.
3. Select EPSON on your desktop.
Then select SP820 Series in the
window that opens.

Select SP820 Series
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4. If you set up an administrator
password, you see this screen. Click
the lock icon, then enter you password
and click OK.
5. Click Continue, then read and agree
to the license agreement to continue
the installation.
6. Select the OS X drive or partition and
click Continue.
Click the lock icon

7. When you see the Easy Install screen,
click Install.
8. Follow the on-screen instructions to complete the installation and restart your
Macintosh.
9. After your Macintosh restarts, select
follow the on-screen instructions.

to install Film Factory for OS X and

10. Select
to install ArcSoft PhotoImpression and follow the on-screen
instructions.
11. Select
to install the EPSON Printer Information Center icon on your
desktop and follow the on-screen instructions.
12. Open the OS X Applications folder, then open the Utilities folder and select
Print Center.
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Note: If you see this screen, click Add.
If SP820 Series already appears in the
Printer list, go to step 15.

13. At the Printer List screen, click Add Printer.
14. Select EPSON USB, click SP820 Series(USB), then click Add.

Your printer appears on the printer list.
15. Close Print Center and start up your Macintosh in OS 9.x or in Classic mode.
Follow the instructions in the next section to install the OS 9.x printer driver and
optional software for your Macintosh Classic applications. (You don’t need to
reinstall your printer movies and manual.)

Installing Printer Software for Mac OS 9.x
1. Turn on your Macintosh. (Make sure your printer is connected and turned on.)
2. Put the EPSON CD-ROM in your CD-ROM or DVD drive and wait a few
seconds for the CD-ROM to be recognized.
3. Select EPSON on your desktop,
if necessary. Then select EPSON
in the window that opens.

Installing Your Printer Software
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4. Read and agree to the license agreement to
continue the installation.
5. Click Install Printer Driver and follow the
on-screen instructions to install the driver
and restart your Macintosh.
6. After your Macintosh restarts, register your
printer with EPSON as instructed.
7. Open the Chooser in the Apple menu. Select
SP820 Series, then select your USB port
and turn on background printing.
8. Close the Chooser.
9. Select EPSON in the window on your
desktop again. You see the Install Menu.
10. Click Install Optional Software and select
the software you want to install from the
next menu. Follow the on-screen
instructions, then return to the Install Menu.
11. Click Install Printer Movies and Manual
to install the EPSON Printer Information
Center on your desktop. It includes helpful
printer animations and an additional
manual.
12. When you’re finished, click Exit and remove the CD-ROM. Keep the CD-ROM
in case you need to reinstall any software later. You’re ready to print.
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Installing Printer Software on
Windows 2000
1. Make sure your printer is set up, connected to your printer, and turned on, as
described on the Start Here sheet.
2. Turn on your computer.
3. Wait for Windows to detect your printer
connection and display a screen like this:
Don’t click any buttons on the screen yet.
Note: If this screen doesn’t appear, make sure
your printer is turned on and connected.

4. Put the EPSON CD-ROM in your
CD-ROM or DVD drive and wait a few
seconds for the CD-ROM to be recognized.
5. Click Next at the Found New Hardware Wizard screen.
6. Click the Search for option, then click
Next.

7. Click CD-ROM drives, then click Next.
8. At the next screen, click Next.

Installing Your Printer Software
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9. Installation proceeds automatically. At the
final Found New Hardware Wizard screen,
click Finish.
10. After a moment, you see a license agreement
screen. Read and agree to the license
agreement to continue the installation.

11. At the Options Menu, click Print a Test
Page to check your installation. (If the page
doesn’t print correctly, see page 46 for a
solution.)
12. Select Install Optional Software. Select
the software from the next menu and follow
the on-screen instructions.
13. Select Install Printer Movies and Manual
and follow the on-screen instructions.
14. Click Exit, register your printer with EPSON, and restart your system. You’re
ready to print.

Installing Printer Software on Windows 95
1. Make sure your printer is set up, connected to your printer, and turned on, as
described on the Start Here sheet.
2. Turn on your computer. If you see a New Hardware Found screen, click Cancel.
3. Put the EPSON CD-ROM in your CD-ROM or DVD drive.
4. After a moment, you see a blue EPSON screen and a license agreement. Read and
agree to the license agreement to continue the installation.
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5. At the Install Menu, select Install Printer
Driver and follow the on-screen
instructions.
6. When you return to the Install Menu, select
Install Optional Software. Select the
software from the next menu and follow the
on-screen instructions.
7. When you return to the Install Menu, select
Install Printer Movies and Manual and
follow the on-screen instructions.
8. Click Exit, register your printer with EPSON, and restart your system. You’re
ready to print.

Installing Your Printer Software
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Requirements and Notices

Windows System Requirements
To use your printer and its software, your system should have:
■

A Microsoft Windows compatible PC with a Pentium® or better processor (Windows 98/95),
Pentium 150 MHz or better (Windows Me), or Pentium 133 MHz or better (Windows 2000/XP)

■

Microsoft Windows 95, 98, Me, Windows 2000, or Windows XP

■

At least 16MB of RAM (Windows 98/95), 32MB (Windows Me), or 64MB (Windows 2000/XP)

■

50MB of free hard disk space (100MB or more recommended)

■

VGA or better display adapter and monitor

■

CD-ROM or DVD drive for installing the printer software

■

For USB connection: a computer running Windows 98, Windows Me, Windows 2000, or
Windows XP with a Windows-compliant USB port and a shielded USB “AB” cable.
For parallel connection: a high-speed, bidirectional, IEEE-1284 compliant parallel cable (6 to
10 feet long) with a D-SUB, 21-pin, male connector for your computer and a 36-pin Centronics®
compatible connector for the printer.

Macintosh System Requirements
To use your printer and its software, your system should have:
■

An Apple® iMac™ series, Power Macintosh® G3 or G4, PowerBook,® or iBook™

■

Mac OS 8.6 through OS X 10.1 or higher (Mac OS 9.0 or later recommended)

■

At least 16MB of available RAM (48MB recommended)

■

At least 50MB of free hard disk space (100MB recommended)

■

VGA display or better

■

CD-ROM or DVD drive for installing the printer software

■

A shielded USB “AB” cable.
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Important Safety Instructions
Before using your printer, read the following safety instructions to make sure you use the printer safely
and effectively:
■

Be sure to follow all warnings and instructions marked on the printer.

■

Use only the type of power source indicated on the printer’s label.

■

Connect all equipment to properly grounded power outlets. Avoid using outlets on the same
circuit as photocopiers or air control systems that regularly switch on and off.

■

Place the printer near a wall outlet where the plug can be easily unplugged.
Placez l’imprimante près d’une prise de courant où la fiche peut être débranchée facilement.

■

Do not let the power cord become damaged or frayed.

■

If you use an extension cord with the printer, make sure the total ampere rating of the devices
plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total
ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s ampere
rating.

■

Keep your printer and computer system away from potential sources of electromagnetic
interference, such as loudspeakers or cordless telephone base units.

■

Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.

■

Leave enough room around the printer for sufficient ventilation.

■

Do not place the printer near a radiator or heating vent or in direct sunlight.

■

Place the printer on a flat, stable surface that extends beyond the printer base in all directions. The
printer will not operate properly if it is tilted or at an angle.

■

Turn off and unplug the printer before cleaning. Clean with a damp cloth only. Do not spill liquid
on the printer.
Caution: Always turn the printer off using the Ppower button. Don’t switch off the power
strip or unplug the printer until the green Ppower light is off.

■

Do not block or cover the openings in the printer’s case or insert objects through the slots.

■

Except as specifically explained in this manual, do not attempt to service the printer yourself.

■

Unplug the printer and refer servicing to qualified service personnel under the following
conditions:
If the power cord or plug is damaged; if liquid has entered the printer; if the printer has been
dropped or the case damaged; if the printer does not operate normally or exhibits a distinct change
in performance. Adjust only those controls that are covered by the operating instructions.
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Ink Cartridge Safety Instructions
■

Keep ink cartridges out of the reach of children and do not drink the ink.

■

Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply
port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them
immediately with water.

■

Do not put your hand inside the printer or touch the cartridge during printing.

■

Do not move the print head by hand. You may damage the printer.

■

Install the ink cartridge immediately after you remove it from its package. Leaving the cartridge
unpacked for a long time before use can result in reduced print quality.

■

Do not use an ink cartridge beyond the date printed on the cartridge carton. For best results, use
up the ink cartridges within six months of first installing them.

■

Store ink cartridges in a cool, dark place.

■

After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room
temperature for at least three hours before using it.

■

Do not shake an ink cartridge; this can cause leakage.

■

Do not dismantle the ink cartridges or try to refill them. This could damage the print head.

■

Do not touch the green IC chip on the side of the cartridge. This may affect normal operation and
printing.

■

If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and
store it in the same environment as the printer. Note that there is a valve in the ink supply port,
making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that
the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area.

■

Before transporting the printer, make sure the print head is capped in the far right position and the
ink cartridges are in place. Tape the ink cartridge holder to the printer case to make sure it remains
in the proper position.

ENERGY STAR Compliance
As an ENERGY STAR Partner, EPSON has determined that this
product meets the ENERGY STAR guidelines for energy efficiency.
The EPA ENERGY STAR office equipment program is a voluntary
partnership with the computer and office equipment industry to
promote the introduction of energy-efficient personal computers,
monitors, printers, fax machines, and copiers in an effort to reduce
air pollution caused by power generation.
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FCC Compliance Statement
For United States Users
This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses, and can
radiate radio frequency energy and, if not installed and used in accordance with the instructions, may
cause harmful interference to radio or television reception. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause interference to radio
and television reception, which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following measures:
■

Reorient or relocate the receiving antenna.

■

Increase the separation between the equipment and receiver.

■

Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

■

Consult the dealer or an experienced radio/TV technician for help.

WARNING: The connection of a non-shielded equipment interface cable to this equipment will
invalidate the FCC Certification of this device and may cause interference levels which exceed the
limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a
shielded equipment interface cable with this device. If this equipment has more than one interface
connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly
approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users
This Class B digital apparatus complies with Canadian ICES-003.
Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
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Declaration of Conformity
According to 47CFR, Part 2 and 15 for Class B Personal Computers and Peripherals; and/or
CPU Boards and Power Supplies used with Class B Personal Computers:
We:

EPSON AMERICA, INC.

Located at:

MS: 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and
15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative
unit tested and found to be compliant with the standards. Records maintained continue to reflect the
equipment being produced can be expected to be within the variation accepted, due to quantity
production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the
following two conditions: (1) this device may not cause harmful interference, and (2) this device must
accept any interference received, including interference that may cause undesired operation.
Trade Name:

EPSON

Type of Product: Ink Jet Printer
Model:

B163A
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Epson America, Inc. Limited Warranty
What Is Covered: Epson America, Inc. (“Epson”) warrants to the first retail purchaser that the EPSON
printer covered by this limited warranty statement, if purchased and used in the United States or
Canada, conforms to the manufacturer’s specifications and will be free from defects in workmanship
and materials for a period of one (1) year from the date of original purchase. Epson also warrants that
the consumable ink cartridges enclosed with the printer will perform to the manufacturer’s specified
usage, which usage may expire before the expiration of the limited warranty for the EPSON printer.
For warranty service, you must provide proof of the date of original purchase.
What Epson Will Do To Correct Problems: Should your EPSON printer prove defective during the
SM
warranty period, please call the EPSON Connection at (562) 276-7282 (U.S.) or (905) 709-2567
(Canada) for warranty repair instructions and return authorization. An Epson service technician will
provide telephone diagnostic service to determine whether the printer requires service. If service is
needed, Epson will, at its option, exchange or repair the printer without charge for parts or labor. If
Epson authorizes an exchange for the defective unit, Epson will ship a replacement printer to you,
freight prepaid so long as you use an address in Canada or the U.S. (excluding Puerto Rico and U.S.
Possessions). Shipments to other locations will be made freight collect. You are responsible for securely
packaging the defective unit and returning it to Epson within five (5) working days of receipt of the
replacement. Epson requires a debit or credit card number to secure the cost of the replacement printer
in the event that you fail to return the defective one. If your printer is being repaired, Epson will direct
you to send your printer to Epson or its authorized service center where the printer will be fixed and
sent back to you. You are responsible for packing the printer and for all costs to and from the Epson
authorized service center. When warranty service involves the exchange of the printer or a part, the
item replaced becomes Epson property. The replacement printer or part may be new or refurbished to
the Epson standard of quality, and at Epson’s option, may be another model of like kind and quality.
Epson’s liability for replacement of the printer will not exceed the original retail selling price of the
covered printer. Exchange products and parts assume the remaining warranty period of the original
product covered by this limited warranty.
What This Warranty Does Not Cover: This warranty covers only normal use in the United States and
Canada. This warranty is not transferable and will not apply to products purchased from an end user.
This warranty does not cover any color change or fading of prints or reimbursement of materials or
services required for reprinting. This warranty does not cover damage to the EPSON product caused
by parts and supplies not manufactured, distributed or certified by EPSON. This warranty does not
cover ribbons, ink cartridges or third party parts, components or peripheral devices added to the
EPSON product after its shipment from Epson, e.g., dealer or user-added boards or components.
Epson is not responsible for warranty service should the Epson label or logo or the rating label or serial
number be removed or should the product fail to be properly maintained or fail to function properly as
a result of misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters
such as fire, flood, and lightning, improper electrical current, software problems, interaction with
non-Epson products, or service other than by an Epson Authorized Servicer. If a claimed defect cannot
be identified or reproduced, you will be held responsible for the costs incurred.
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THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF
ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR
FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE
EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS
AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED
ABOVE. UNLESS STATED HEREIN, ANY STATEMENT OR REPRESENTATIONS MADE
BY ANY OTHER PERSON OR FIRM ARE VOID. EXCEPT AS PROVIDED IN THIS
WRITTEN WARRANTY, NEITHER EPSON AMERICA, INC. NOR ITS AFFILIATES SHALL
BE LIABLE FOR ANY LOSS, INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT,
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE
OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH
OF WARRANTY OR ANY OTHER LEGAL THEORY.
In Canada, warranties include both warranties and conditions.
Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some
jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the
above limitations and exclusions may not apply to you. This warranty gives you specific legal rights and
you may have other rights which vary from jurisdiction to jurisdiction.
Epson America, Inc. ■ P. O. Box 93012 ■ Long Beach, CA 90809-3012
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Index
A
Adobe Photoshop, P.I.M. plug-in for, 3, 29 to 32
Advanced settings, 17 to 20
Aligning print head, 39
ArcSoft PhotoImpression, 3, 24, 54
Automatic mode, Macintosh, 13, 15, 48

B
Background printing, 13
Banding, 48
Basic printing
Macintosh, 12 to 16
Windows, 10 to 12
Black Ink Only setting, 17, 49
Blank pages, 50
Blurry images, 48
BorderFree printing, 1, 22 to 23, 27
Borderless setting, 23
Bright White Paper, 21
Browser, 5
Buttons, 33, 43

C
Cable, printer, 63
Cancelling printing
Macintosh, 13, 16
Windows, 11
Characters, incorrect, 50
Checking printer, 45
Chooser, Macintosh, 46, 50

Cleaning
print head, 33 to 35
printer, 40
sheets, 40
Color Management settings
Mac OS 8.6 to 9.x, 19 to 20
Mac OS X, 15
Windows, 17
Color problems, 49
ColorLife Photo Paper, 21
ColorSync, 15, 19 to 20, 49
Control panel, 43 to 44
Controlling printing
Macintosh, 13, 16
Windows, 11
Copies setting, 51
Custom settings
Macintosh, 19 to 20
Windows, 17 to 18

D
Declaration of Conformity, 67
Default settings, Windows, 12
Documentation, 4 to 6
Double-Sided Matte Paper, 21

E
ECP/DMA mode, 47
Electronic manual, 4 to 6
Energy Star compliance, 65
Envelopes, 9
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EPSON
help, 53 to 54
ink, 36
papers, 21 to 22
Printer Information Center, 4 to 6
SoundAdvice, 53
Store, 36
warranty, 68 to 69
EPSON PhotoCenter, 4
Exif Print
description, 2 to 3
with Film Factory, 24 to 28

F
Faint images, 49
FCC Compliance Statement, 66
Film Factory, 3, 24 to 28
Film, Photo Quality Glossy, 21
Flip Horizontal setting, 50

G

I
ICM (Image Color Matching) setting, 17, 49
Incorrect
characters, 50
colors, 49
margins, 51
Ink cartridge
level of ink in, 11, 13, 35 to 36, 44
ordering, 36
problems, solving, 46
replacing, 35 to 38
safety instructions, 36 to 38, 65
Ink Jet Transparencies, 21
Ink level, checking
Macintosh, 13, 36
Windows, 11, 35
Installation problems, 46
Inverted image, 50
Iron-On Transfer Paper, 21, 50

J
Jams, paper, 50

Gamma setting, 17, 20, 49
Glossy media, 21 to 22
Grainy prints, 49
Greeting Cards, Glossy Photo, 21 to 22

H
Head Cleaning utility, 33 to 34
Help
EPSON, 53 to 54
see also Printer Information Center and
Troubleshooting
High Speed setting, 47
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Index

L
Layout problems, 51
Layout settings
Macintosh, 13, 15
Windows, 17 to 18
Letterhead, 8
Lights, 33, 43 to 44
Luster Photo Paper, 21 to 22

M
Macintosh
basic printing, 12 to 16
Chooser, 46, 50
installing software, 55 to 58
system requirements, 63
Maintaining printer, 33 to 40
Margins, incorrect, 51
Matte Paper - Heavyweight, 21 to 22
Matte Paper, Double-Sided, 21
Media Type setting
Mac OS 8.6 to 9.x, 13, 19 to 20, 48
Mac OS X, 15, 19 to 20, 48
selecting correct, 21
Windows, 11, 17, 48
MicroWeave setting, 47
Mirror Image setting, 50
Monitoring ink level
Macintosh, 13, 36
Windows, 11, 35
Movies, Print Show, 4 to 5
Moving printer, 41

N
Network printing, 46
Noise, printer, 47
Nozzle Check, 34 to 35

O
Orientation setting, 11 to 12, 14, 23

P
P.I.M., see PRINT Image Matching
Page Setup, Macintosh, 12, 14
Paper
EPSON, 21 to 22
feeding problems, 50
loading, 8 to 9
orientation, 11 to 12, 14, 23

Paper Size setting, 9, 11 to 12, 14
Parallel port, 47
Photo Paper, 21 to 22
Photo Quality Glossy Film, 21
Photo Quality Glossy Paper, 21
Photo Quality Ink Jet Paper and Cards, 21
Photo RPM setting, 17, 20
Photo Stickers, 21
PhotoCenter, EPSON, 4
PhotoEnhance, 49
PhotoImpression, ArcSoft, 3, 24, 54
Premium Bright White Paper, 21
Premium Glossy Photo Paper, 21 to 22
Premium Luster Photo Paper, 21 to 22
Premium Semigloss Photo Paper, 21 to 22
Preprinted paper, 8
Previewing printout, 11, 13 to 15
Print dialog box, 10
Print head
aligning, 39
cleaning, 33 to 35
Print Head Alignment utility, 39
PRINT Image Matching
description, 2 to 3
plug-in for Photoshop, 3, 29 to 32
with ArcSoft PhotoImpression, 3, 24
with Film Factory, 24 to 28
Print quality problems, 48 to 49
Print Show movies, 4 to 5
Printer
cable, 63
check, 45
cleaning, 40
control panel, 43 to 44
maintaining, 33 to 40
noise, 47
parts, 43
problems, 44 to 45, 47
transporting, 41
Printer Information Center, 4 to 6

Index
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Printing
advanced, 17 to 20
BorderFree, 1, 22 to 23, 27
controlling, 11, 13, 16
Macintosh, basic, 12 to 16
Windows, basic, 10 to 12
with custom settings, Macintosh, 19 to 20
with custom settings, Windows, 17 to 18
with PRINT Image Matching, see PRINT
Image Matching
Problems
diagnosing, 44 to 45
installing software, 46, 55 to 61
miscellaneous, 50
paper feeding, 50
print quality, 48 to 49
printer, 47
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EPSON Ink Jet Papers and Ink Cartridges
Use EPSON® paper and inks to get the same photo quality results that have earned EPSON’s printers
all of their awards! EPSON papers are specially coated to work with EPSON genuine inks. Here are
details about just a few of EPSON’s papers, your printer’s ink cartridges, and EPSON project ideas:

Glossy Photo Paper and Panoramic Photo
Paper
Photo lab quality, heavier weight glossy paper available in a
variety of sizes. Perfect for color photo keepsakes of
snapshots, framed art, banners, and panoramics.

ColorLife Photo Paper
ColorLife™ Photo Paper delivers colorful, fade-resistant photos with a smooth satin
finish. Results are brilliant, professional images that look and feel like traditional
photographs.

Premium Glossy Photo Paper
Water-resistant paper with a high gloss finish that looks and feels just like a
traditional photo. Perfect for all photographic applications and available in a variety
of popular photo sizes, such as 4 × 6, 5 × 7, 8 × 10, and letter. Framing is
recommended for this paper type.

EPSON Ink Cartridges
For best results, always use genuine EPSON ink cartridges.
Black
Color

T026201
T027201

For more information on other EPSON products and fun project ideas,
look for the EPSON Print LabSM Series at www.printlabseries.com.

See the inside back cover for a list of EPSON papers and ink cartridges, and ordering information.

1

How To Order EPSON Ink and Paper
To order EPSON ink cartridges, paper, and other printing media, contact your dealer or call
the EPSON Store at (800) 873-7766 or visit www.epsonstore.com (U.S. sales only).
In Canada, please call (800) 463-7766 for dealer referral.

EPSON Ink Cartridges
Black:
Color:

T026201
T027201

EPSON Papers
Paper name*

Size

Part number

EPSON Premium Bright White Paper

Letter (8.5 x 11 inches)

S041586

EPSON Photo Quality Ink Jet Paper

Letter (8.5 x 11 inches)

S041062

A4 (8.3 x 11.7 inches)

S041061

Legal (8.5 x 14 inches)

S041067

EPSON Photo Quality Ink Jet Cards

A6 (4.1 x 5.8 inches)

S041054

EPSON Photo Paper or EPSON Glossy Photo Paper

4 x 6 inches, non-perforated, BorderFree

S041458

4 x 6 inches, with perforated edges

S041134/S041671

Letter (8.5 x 11 inches)

S041141/S041272/
S041271/S041649

Panoramic (8.3 x 23 inches)

S041145

Letter (8.5 x 11 inches)

S041654

EPSON All Purpose Glossy Paper
EPSON ColorLife Photo Paper

Letter (8.5 x 11 inches)

S041500

EPSON Double-Sided Matte Paper

Letter (8.5 x 11 inches)

S041568

Letter (8.5 x 11 inches)

S041257

8 x 10 inches, BorderFree

S041467

EPSON Matte Paper Heavyweight

EPSON Premium Glossy Photo Paper

Letter (8.5 x 11 inches)

S041286/S041667

4 x 6 inches, BorderFree

S041682

5 x 7 inches, BorderFree

S041464

8 x 10 inches, BorderFree

S041465

EPSON Premium Semigloss Photo Paper

Letter (8.5 x 11 inches)

S041331

EPSON Premium Luster Photo Paper

Letter (8.5 x 11 inches)

S041405

EPSON Ink Jet Transparencies

Letter (8.5 x 11 inches)

S041064

EPSON Photo Quality Self Adhesive Sheets

A4 (8.3 x 11.7 inches)

S041106

EPSON Iron-On Transfer Paper

Letter (8.5 x 11 inches)

S041153/S041155

EPSON Glossy Photo Greeting Card Kit

Letter (8.5 x 11 inches); perforated edges

S041606

EPSON Photo Stickers Kit (CD-ROM/paper)
EPSON Photo Stickers (refill)

A6 (4.1 x 5.8 inches)
A6 (4.1 x 5.8 inches)

S041144-KIT
S041144

* Availability of paper types varies by location. See page 21 or your paper instructions to select the Type or Media Type
setting.

